
Useful programs to use with this
      This program uses a number of different compression programs. This is by choice, not necessity. 
Windows unzipping .dlls are available to all programmers regardless of ability for as little as $75, or from 
PKWare itself, for $400 by which any expert or even beginner programmer can instantly add to this 
capacity to their programs if they wish. So why use the DOS programs? Greater speed, automatic 
compatibility with future versions, providing they do not change the commands, a common interface 
for all supported programs, and the reliability and assurance of knowing you are not using just an 
imitation algorithm whose compatibility may be questionable. The other issue is size. As one can see, 
this program is roughly the same size as some decompression programs (not counting VBRUN300.DLL 
which is used by numerous other programs), maybe just a little larger than others but may have far more
features, not the least of which is the picture viewing capacity which alone would take up nearly as much 
space if you were to use another program which could only show and print pictures. If you have the DOS 
versions of zip as most who received this program probably do, and this program, you do not need 
additional .dll files which basically do the same thing, but may be larger and slower.
      The useful programs to have to use the decompression features of this program are PK ZIP 204g, 
ARC 6.02, ARJ 2.41, LHA 2.13, and ZOO 2.01.    With this and with these programs you can 
decompress, update, recompress when done, view the contents of these compressed files, add to 
them, delete files from them, and selectively decompress files from them, all from within the 
Windows environment, even password protected ones, 

all without knowing a single one of the 
commands needed to use these files. 
      Any of these formats you wish to use should be in a path set directory, which means you should copy 
them into your \dos, \windows, or root directory which would have a line in your autoexec.bat file 
something like    path=c:\dos; c:\windows; c:\windows\system ;c:\. This means the computer can find these
files from any directory. This program can also run ZR IconWorks, now via the program ZR Photo Pro, 
and Readdx(RDX 4).
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How to Unzip a file
There are 3 ways to decompress each of the following types of compressed files which this program 
supports, ZIP, ARC, ARJ, LZH, and ZOO. You can decompress for use by clicking the name of the file, 
then the button 'Load' (or using open on the file menu, or dropping the name of the file onto the Open 
button). Decompress for use means just decompress the file so you can use the contents of it (ideal for 
when you download ZIPPED files which contain setup files which will create its own directory and 
files so you would have to erase the originals anyway), or you can 'permanently' decompress it (this 
just means it won't recompress when you exit) by clicking the ZIP tab on the bottom and then clicking 
'Uncompress' when the appropriate file is highlighted, or by just dragging the name of the file from the file 
list and dropping it onto the 'Uncompress button'. By doing this, you have 2 more options, decompress 
into the same directory the file is in or decompress into a directory equal to the name of the file. This 
means that if you are in a directory called c:\onlineservice\download and you decompress a zip file called 
newgame.zip into a new directory, ZR-FW will create a new directory c:\onlineservice\download\
newgame, copy the original file into that directory and decompress it into that directory. You can even do 
these options using password protected files.
`
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Making a compressed file
      You can use this program to ease the task of making compressed files, even making those which are 
password protected if that program supports passwords. To the best of my knowledge neither LZH nor 
ZOO does but ZIP, ARC, and ARJ most certainly do. To make a compressed file, click on 'List' on the 
menu bar and then 'Start new list' or you can click the ZIP tab on the bottom and then click 'Make ZIP', 
either way a list will be created in the middle to which you can add the names of whichever files you wish 
to include in the compressed file. You can even change directories while adding files to the list, BUT DO 
NOT CHANGE DRIVES while doing this, that would copies the names to a different list. Once you are 
done adding names to the list, click the tab at the bottom called 'LIST' or click 'LIST' on the main menu 
bar and then click 'View file list'. This will show you the contents of the list on a larger list. From here you 
can even launch the programs or files by double-clicking them if it is an old list and you are not sure if 
these are the right files. From here simply click compress files and follow the instructions from there. The 
new file created will reside in the root directory of that drive. You can also have the    option of making 
single compressed files, or .exe and .txt files compressed.
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Setting Extensions
      This program creates a list of extensions (those 3 letters after a period telling you what kind of file it is) 
so it can load files into the appropriate programs right from within a compressed directory. You can add to 
this extension setup, create a new one or edit it in Notepad by clicking the corrosponding item in the 
'Setup' menu on the menu bar. The first item in the setup file is the default for any unknown extensions. 
The pattern for this setup file is the program name on the first line, the extensions (you must have a 
period before the 3 letter extension) on the second line, again a program name on 3rd, extensions on 4th 
and so on. If you use the append or make new extension setup, click ok to add the name and extension 
you give, and cancel when you are done adding.
      By setting extensions ZR-FW becomes more than just a decompression tool or a file viewer, you can 
load files into any number of different programs all from the same directory again and again without 
having to go to the file menu of a program, then the open dialog box, then selecting the name, then 
clicking OK, you can just keep dropping away the names on 'Open' and load as many versions of the 
program as you need. It can connect you with any program you need to use whenever you want to use it.
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Single compressed files
      Along with decompressing files for use and recompressing them again when exiting, this is one of ZR's
oldest features and it remains almost completely unchanged from its dos roots. Since exe (programs) are 
usually the largest pieces of a set of files and since they do not change by using them, this program can 
compress them into .exc files, then automatically uncompress them when you want to use them and 
erase them when you are done without you having to do anything at all because there is nothing that 
changes when you use it so you do not have to decide whether or not to save any changes. Ideal for 
large DOS programs you launch from Windows, for Windows programs a ZRC Directory will be created.
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Viewing graphics files
    This program supports JPEG, GIF, BMP,    PCX, DIB, TGA, and TIF picture files. You can load files by 
clicking their names and then clicking Open or by clicking the name and then file and open from the menu
bar, or dragging and dropping the file name from the file list onto Open or by double-clicking a graphics 
file from file list, or by double-clicking a graphics file name in a ZRC directory. You can zoom in or out, and
pan left, right, up or down, by clicking Z-I or Z-O, P-L, P-R, P-U, or P-D on the menu bar. Mega zoom, 
mega panning, and super panning are for large (in size) picture files which take a while to change. You 
can also adjust, mirror, rotate, and save files in any of the supported formats. This provides an easy way 
to converts Gifs or Bmps to the more compressed and increasingly more common Jpeg versions. There 
also shortcut keys for mega and super panning, mega zoom, flip horizontal, flip vertical, and and rotate. 
There are 4 ways to make a picture file fit on your printer. 1st is to rotate is so that the height is greater 
than the width (if you have standard paper sizes). 2nd is 2 lower the resolution, or dots per inch. 3rd is to 
shrink the picture before printing. And finally, if you want the highest possible resolution but cannot fit the 
whole picture on your printer, you can cut it up to pieces using Copy selection and paste new. Click the 
mouse on the part of the picture you wish print, holding the mouse button down move down and to the 
right, release and click on Copy selection, the click Paste new picture. You can also use this to crop out 
wide boarders or to to better frame your pictures. Shrink can also be used to make to make thumbnails of 
your pictures. Clicking info will tell you the size, type, and other info on your pictures. This can be useful 
when shrinking or Copy and Pasting new. Double clicking on the picture is a short-cut for closing.
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Open
      Open (previously called Load) is the main feature of this program and is always the default for double-
clicking a file in the main file list. Double-clicking the file list will give you access to Open even when the 
button Open has been changed to another feature by the ZIP tab or the UUE tab on the bottom bar. Open
will load compressed files into temporary ZRC directories, load picture files into the graphics viewer, run 
programs, load programs and files together if the extension of the file matches one of the extensions in 
the setup file and it will automatically decompress/ run/ recompress again (erase) .exc single compressed
files. These same events happen by using Open on the file menu and by dropping names on the Open 
button when it called 'Open' (when the Main tab is highlighted).
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ZRC directories
      A ZRC directory is what comes on when you click Load on a compressed file. This is an imaginary 
directory defined by this program for the purpose of keeping the uncompressed versions of files separate 
for temporary use. When clicking recompress (the equivalent of EXzip on previous versions) the 
uncompressed versions of files in the compressed file will disappear. For this reason, if you change any of
the files, simply click Update and the corrosponding files in the compressed file will be updated to reflect 
these changes. You can add files to existing compressed files using ZRC directories and delete unwanted
files from them. You also have access to any program listed in the setup file extensions by double-clicking
on the items in the list. This duplicates the Load feature of the main view area. You can also lauch 
programs or view graphics files, or do anything that any program you include in set extensions can do to 
any of the files listed.
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Compressed files
      Compressed files are groups of files shrunken into one smaller one for the purpose of making it less 
time consuming and costly to transfer them over telephone lines and on disks. This program extends 
that purpose to compressing just the files you don't use very often without your having to 
compress a whole drive or back them up to disks. The most common compression standard for PC 
computers is the ZIP file format. This program runs a number of these other programs which compress 
files beneath it rather than internally. By using the original versions of these compression programs, 
compatibility with all files made by them is assured, plus you have the added option of upgrading this 
program without doing anything simply by obtaining newer versions of those programs as they come out. 
DOS versions also usually run considerably faster than their Windows counterparts and this program 
gives you the speed of the DOS versions coupled with the convenience of Windows.
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UUE files
      UUE stand for Unix to Unix Encoding. This is the most common format used to send binaries (pictures,
sound, programs) over the Internet, via electronic mail, or posting to Usenet or BBS's. This program uses 
freeware DOS command versions of uuencode and uudecode because they are smaller and faster than 
would be possible to achieve in a Windows version. UUdecoding of large files is almost instantaneous, it 
seems to me anyway. This program supports uuencoding, decoding, merging broken up UUE files, 
breaking up UUE files to match you mail servers limit, and extracting UUE files from online logs. These 
features are available when clicking on the UUE tab at the bottom of the Window.
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Main tab
      The main tab at the bottom of the screen is the default tab when the program is turned on. It sets the 
first command to Load, the second to the compressed file viewer, and the others to Make Directory, 
Remove Directory, and Rename. Make directory makes a new directory in the currently open directory, 
remove directory removes only empty directories. To remove a full directory drop files into trash first, or if 
there is many of them, click on the 'File' menu, click 'Delete files' and click *.*, and ok.
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ZIP tab
      This tab is to give you easy access to the decompression features, Using this is not necessary for 
temporary decompression but you can use it to permanently uncompress files, start a zip file, make a 
single compressed file, or to view contents of a compressed file, though this feature is also on the Main 
tabs command buttons.
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Viewer- compressed files
      The second button on the Main tab commands and on the ZIP tab commands is the compressed file 
viewer. You can use this to view the contents and stastics of the files in a compressed file, compression 
ratios, sizes compressed, uncompressed, dates of last change, and so on, of files in a compressed file 
without having to decompressed it. You can also use this to create selective compressed directories, or 
mini ZRC directories made up of only those files which you wish to use instead of having to decompress 
all of them at once.
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Password protected files
      This program supports password protected files in the Zip, Arc, and Arj formats. Password protected 
means these files are scrambled using a password only the creator of the archieve knows. You must use 
this password to unscramble the files as well. To create a password protected file, chose to when asked 
when making a compressed file. To decompress a password protected file, click the green 'NP' below the 
directory list box and next to the drive box, to change it to 'PW'. These stand for 'no password' and 
'password' respectively. When loading a compressed file you will be prompted for a password if the green 
'NP' is set to 'PW'. To permanently decompress a password protected file, click the ZIP tab, then PW 
uncompress.
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List
      The list function and the ZRC Directory (formerly ZIP directory) were always the heart of ZR. One 
handled making compressed files, the other handled uncompressing and recompressing them. With List 
you can build lists of files spanning many directories and magically make them into a single compressed 
file (without moving the originals) in one step. Other list functions have also always included copying the 
list files, moving the list files, and erasing the list files. These other list functions can be done at any later 
date after you compress the files in the list and are assured that the copies of the files were not corrupted 
by the compression process. Later, one would assume you might want to move or erase the originals so 
the list is maintained until you decide to erase it.    You can also use list solely for the purpose of 
making lists of files to copy all at once to other drives and directories from any directory on the 
current drive! Now the list function also links to Backup and on some versions, to a File Finder.
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Backup files
      Backup files is a feature that first appeared in ZIP Runner 5.0 for Windows and ZR 5.0 for DOS. Its 
purpose is to scan all files on your drive and backup any made since a particular date and optionally to 
compress them. Now with any version 6 of ZRW or ZRFW, the names of the files are copied to the List for
compression, or to move or copy them without compression. A file gauge shows progress in copying 
backup files to disks and will prompt you for new disks when full, sort of like a reverse setup file.
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Drag and drop events
      Using this program, in addition to drag and drop loading of files, programs, and programs and files 
together, you can drag and drop move or copy files to other directories, or delete them by dropping them 
into a trash can. You can also drop the names of files into a list for compressing them, moving or copying 
many files at once to other drives, drop the names into lists of texts files or broken up UUE files to merge, 
drag and drop UUEncode or decode files, plus many other drag and drop features. One of this programs 
key features, building lists of files for compression, moving, copying, or erasing many files at once is also 
now a drag and drop event. You can also drop and add files to existing compressed files.
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Merge events
      You can use this program to merge text files or UUE files. To begin merging text files select 'Merge text
files' from File in main menu. To begin merging UUE files back into one continuous UUE file, click the 
UUE tab at bottom of the program, then click the 'Merge UUEs' button. To merge either text or uue files, 
drop names (DO NOT CHANGE directories while dropping) into center drop zone and click the green x's 
when ready to begin merging. NOTE> This is not may not work with all compressed drives. Merging text 
files is a good way to merge many multiple part UUE files at once. Simply choose merge text files, drop all
the names IN ORDER into the drop area and click green x's when done.    Then choose 'Xtract UUEs' to 
merge all the uue files at once. NOTE> Merging UUEs will not work when files are saved as one long 
continuous line instead of as normal lines under 80 characters long.
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Extract UUE files from log
      This feature is designed to extract all UUE files or multi-part UUE files which are in order from any 
online log. It searches for a Begin statement the starts tracking statements until it finds an end statement. 
If no end statement is found, the file is ended when a new Begin statement is encountered. The new files 
it extracts are called a.uue, b.uue, and so on. This feature works well with Merge text files to merge 
multiple multi-part UUE files at once.
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Readdx
      Readdx via RDX 4.0 is a 256,000 color unlimited sized DOS text reader which this program can shell 
to view text files. No other text reader has this many colors you can adjust just like the colors of a color tv, 
has search with match count, ratio driven side bars to show at a glance the size of the text, multiple user 
1 key saved color and preference settings, plus many other features.
      Readdx is also the parent program of all ZIP Runner (ZR) programs. What started out as a text reader 
which could shell to compression programs to shrink and auto-decompress text files for use was spun off 
into a version which would decompress a whole compressed file into an imaginary 'directory', which would
give a user access to read files and run programs within that directory, and then would recompress it 
when exiting that directory, is now on the verge of becoming a full fledged icon-based program manager 
to complement, if not completely replace (which it likely won't), window's own program manager, with its 
primary purpose being, of course, auto decompression for use / recompression. Such is ZR 
ProgramWorks.
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About ZR PhotoView / ZR Photo Pro
      ZR PhotoView and the new version, ZR Photo 6.2 Pro were cut to varying degrees from the program 
ZR ProgramWorks. They have the same multi-image Jpeg, Gif, Bmp, etc. viewing capacities of ZR 
ProgramWorks though minus the compression features. The newer version is a showcase for what ZR-
PW will be able to do and how far advanced it will be in design to even this program, which will continue 
on as its other half. The new version also includes a special registration fee of only $10 since I need only 
give whoever registers it a code to remove the restrictions on it. With only a fraction of the features of ZR 
ProgramWorks, these ZRPV.EXEs are still impressive over other Jpeg viewers all of which cost far more 
than just $10 and usually can only show one file at a time. And on top of everything else, ZRPV.EXE also 
comes with built-in ZR IconWorks icon editor to create your own custom icons.
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About ZR IconWorks
      ZR IconWorks is a freeware icon editor / creator program that previous versions of ZR-FW ran from the
graphics menu. That option is being continued with this version but instead of shelling to ZRIW.EXE, this 
program now looks for ZRPV.EXE, ZR Photo 6.2 Pro. Since ZR PhotoView and ZR ProgramWorks both 
have ZR IconWorks built-in I figured it would be better for registered users, who would receive ZRPV.EXE
anyway, not to have to be chained to keeping a redundant file.
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About ZR ProgramWorks
 
    ZR ProgramWorks is an extension of ZIP Runner and ZR FileWorks. From the very first ZIP Runner for 
Windows you always had the option of easy access to you favorite most often used zip files, so it was 
only a matter of time before this list was made visual with icons. ZR was always more of a program 
manager than a compression shell and now it gets its chance to prove it. It has always been hard to 
define just what exactly its purpose is (and the graphics viewing didn't help to clarify much). I have always
refered to them as program managers / file managers for compressed files and that is still the definiton I 
think fits the most. Probably I like that definition because by that defintition, no other program can meet 
with this one on a even playing field, and perhaps the only definition by which this program will prevail.
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Graphing directories
 
      You can use this feature to graph sub-directories or a whole drive. This gives you percentages on 
directories many layers deep. To begin, click 'Graph directory' from the File menu or click on 'Graph (x 
many) directories' in the bottom right hand corner of the window. Graphing a whole drive can take a 
minute or two if you have hundreds of mb like I do but for the short wait it gives you a wealth of 
information. In addtion to the size of the total of all subdirectories and their subdirectories 1 level deep,    
and their realtive sizes as percentages of the total drive, once it is done and you can click on the name of 
any of those 1 level deep sub-directories to find out the sizes of ALL sub-directories ALL levels beneath it 
and their precentages realtive to that second subdirectory. In other words, if you found out one directory 
was taking up 30% of your drive, a single click would tell you which directories beneath it had what 
percentages of it which would be causing it to be so big. Plus it graphs the current directories subs total 
sizes on a pie chart to visually show you which directories are hogging the most space.

Helpfile generated by VB HelpWriter.



Register
      Shareware is does not mean free, though it is still one of the best deals under the sun. You get to try 
out really neat stuff and you are trusted to pay for what you like. This means EVERYBODY, not just the 
idle rich or people who test programs for a living, get to see whats at the cutting edge, new or unique, 
without having to spend a fortune to see if the programs really live up to the promises on the box.
      Too many people don't register to warrant shareware releases of most products and many good 
programs die out because people think it really doesn't make a difference. DON'T KID YOURSELF, if you
don't bother, who's to say anyone else will? If you want to see better programs along the lines of ones you
like, only paying for them can make it happen.

If you would like to register this program and receive the programs described within the program under 
Register info on the Help menu, send a check or money order for $22 plus $4 shipping to...

                      Scandere Software
                      PO Box 1329
                      Dennisport, MA    02639
or register via Compuserve, GO SWREG, Register ID number 4470. If you would like to contact 
me regarding other payment options, mulitple users licenses, or setup info, the e-mail address for support
of this program is Jared10@ix.netcom.com

Helpfile generated by VB HelpWriter.



Help for ZR FileWorks
Contents

                            The Competition
                                                                
                              Useful programs to use with this
                              How to unzip a file
                              Making a compressed file
                              ZRC Directories
                              Dragging and Dropping
                              Loading files
                              ZR File List
                              Viewing contents of compressed files
                              Viewing graphics files

                              Register Info

                              About ZR IconWorks
                              About ZR PhotoView / Photo Pro
                              About ZR ProgramWorks
Helpfile generated by VB HelpWriter.



The Competition
      Unless you are extremely well-informed about shareware you have probably never heard of ZIP 
Runner. Unfortunately the competition has. A few months after the release of ZIP Runner for Windows, a 
program specializing in decompression for use, another far more well known program added what 
appeared to be its take on this concept. Much accolades followed their 'innovation' (whether inspired by 
that or not, I cannot say). Now a mere 6 weeks after ZR announced its newest, icon-based 
decompression for use, another version of that 'other' program has appeared with what well sounds like 
an interpertation of this. If again, this could be said to be the case, one cannot fault others for trying to 
keep up to speed, nor do I, but the fact that the industry might ignore such 'borrowing' of ideas when 
again dispensing praise makes what would otherwise be healthy earnestness into unmitigated 
aggriegiousness. If the more known programs are free to take what features they wish from lesser known 
programs AND receive the credit for those ideas, fair and honest competition cannot survive. I do not 
have a staff of programmers, nor a fleet of lawyers, nor friends on staff at major magazines. All I have is 
ideas others do not (did not anyway). I just thought that would count for something more than, it seems, it 
does.

      To their credit, their 'interpertations', if that term might indeed apply in any moral or legal sense (as 
opposed to incredible co-incidences), have been inventive and clever, unlike some others, and have been
somewhat deservedly worthy of note. Lesser informed people might think this program's very existence 
takes its cue from this 'other' program, but it did in fact evolve out of a DOS based text reader    /  program
manager and it still shows its roots at every level. If nothing else, this competition is providing much 
dividends for end users as all competition does, I just hope it can afford to continue as I am sure it would 
if both programs are given the same consideration, and the same scrutiny.
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